In questo primo esercizio ci si € serviti dei programmi Autocad, SAP2000 ed Excel per operare il
predimensionamento di una travatura reticolare.

Il primo passaggio da compiere, una volta definite le caratteristiche principali dell’oggetto di studio,
quello di disegnare la struttura schematicamente come sistema di pit cubi rappresentati unicamente dagli
spigoli e dai segmenti diagonali che dividono ciascuna faccia quadrata in due triangoli. Una volta scelte le
dimensioni del complesso e realizzato su Autocad, si puo importare il modello in SAP2000.

C’e da specificare che esistono due possibilita per il disegno su Autocad, che hanno conseguenze
nell'importazione successiva: si puo disegnare su un solo layer o distinguere i livelli per ciascuna tipologia di
asta (ad esempio orizzontale, verticale, obliqua). Nella prima condizione, si inserisce nel programma il
disegno completo, nel secondo caso & necessario specificare il layer che si sta importando, e va ripetuta la
procedura di importazione per ogni livello (SAP & in grado di riconoscere un layer alla volta).

Il disturbo dovuto alla reiterazione del gesto & ripagato dal fatto che se necessario, sara possibile
evidenziare o visualizzare solo gli elementi di un layer specifico senza dover selezionare elemento per
elemento, semplicemente con un comando.
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[se si desidera non avere problemi con I'importazione, & possibile disegnarla direttamente su SAP2000]



Mentre per gli elementi disegnati direttamente sul programma, se si fa correre I’analisi dei carichi, verra
assegnata automaticamente una sezione, se si importa un file esterno, & necessario scegliere il profilo che il

segmento rappresenta. Lo si fa selezionando le aste (nel nostro caso tutte) e andando su

Assign > frame > frame section > Add New Property

In questo caso abbiamo scelto un pofilato tubolare cavo con sezione circolare, andando sulla tipologia di
materiale ‘Steel’, selezionando ‘Pipe’ e dando un nome alla sezione, che si & lasciata dimensionata secondo

default.

Ci sarebbe anche la possibilita di importare la sezione da un profilario che fa parte della libreria del
programma, selezionando Import invece di Add, aprendo il file EURO.PRO e scegliendo la tipologia tra

quelle proposte.
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Una volta definita la sezione, vanno posizionati i vincoli, esterni e interni. Partendo dai secondi, i vincoli
interni tra le aste di una travatura reticolare del genere sono cerniere. Tuttavia, dato che il programma non
€ in grado di rappresentarle, si puo indicare la loro presenza applicando un rilascio del momento ai nodi tra
le aste (le cerniere interne hanno la caratteristica di avere momento nullo (di non far passare il momento)),
selezionando tutta la struttura e andando su Assign > Frame > Releases/Partial Fixity, spuntando poi il
momento su entrambi gli assi (Moment 22, Moment 33), all’inizio e alla fine dell’asta (start, end), e la
torsione alla fine.
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Per i vincoli esterni basta selezionare i punti che corrispondono ai nodi scelti, andare su Assign > Joint >
Restraint, e spuntare i dati corrispondenti al vincolo scelto o direttamente I'icona che lo rappresenta.

Nel nostro caso abbiamo inserito 12 cerniere disposte come mostrato nell’introduzione.
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A questo punto si puo far correre I’analisi dei carichi con il solo peso proprio della struttura. Si va su
Analyze > Set Load Cases to Run, si disattiva il carico definito come “modal” premendo su “Run/Do not
Run” dopo averlo selezionato, e si procede con “Run Now”.
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Sullo schermo apparira la struttura deformata; per avere informazioni dal punto di vista quantitativo si
possono consultare le tabelle dei risultati dell’analisi premendo Ctrl + T o0 andando su Display > Show
Tables.
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In questo momento cio che ci interessa & conoscere il peso della struttura, ed essendo i nodi a reagire al
carico (in particolare i nodi dove sono stati impostati i vincoli), la tabella che interessera visionare sara
quella dei “Joint Qutput” (spuntare Joint Output e premere ok).
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Una volta che si apre la nuova schermata, dalla tendina si seleziona Joint Reactions, e si esportano i dati su

Excel con il percorso File > Export Current Table > To Excel.

Joint Reactions
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Text Text Text KN KN ml KN-m KN-m KN-m

» 2 DEAD Lin5tatic 27 5476 a 0 0

u DEAD LinStatic 477 18171 56,719 0 [l 0

| W | DEAD | Lebwo | f0M8  t0mis 59 o 0 o

45 DEAD LinStatic 14.135] 4179 17.04| o 0 )
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B4 DEAD LinStatic 20774| 2047| 4321 0 g g

53 DEAD LinStatic 5553] 3745 0123 0 0 0

2 DEAD LinStatic 20575 6383 6145 0 0 o

% DEAD LinStaic 5513] -1.974] 15604 o 0 0

0 DEAD Lintatic 2278 3,047] 10.773] a 0 o

94 DEAD LinStatic 2,182 1495 51,258 0 0 0

108 DEAD LinStatic -31.837| 14155 i) o (] 0
Aecord [4] 4 T el12 Add Tables... | Dere |




La colonna da prendere in considerazione € quella di F3, che indica i carichi sull’asse z.

Si sommano tutti i valori della colonna e si ottiene il carico complessivo che andra sommato al carico totale
dei solai appesi alla reticolare, per poi essere distribuito in maniera uniforme sui nodi.

2 ; Joint  OutputCase CaseType F1 F2 F3 M1 M2 M3

3 | Text Text Text KN KN KN KN-m KN-m KN-m

4 '2 DEAD LinStatic 27,395 -5,476 59,542 0 0 0
5 {34 DEAD LinStatic -34,772  -16,171 56,719 0 0 0
6 3'38 DEAD LinStatic 10,908 -10,615 5,033 0 0 0
7 5'46 DEAD LinStatic 14,135 -4,179 17,04 0 0 0
8 5'62 DEAD LinStatic -39,554 14,039 69,398 0 0 0
9 '64 DEAD LinStatic 20,774 -2,047 -4,321 0 0 0
10 5'68 DEAD LinStatic -5,653 -3,745 0,123 0 0 0
11 ;’72 DEAD LinStatic 20,675 -6,983 61,45 0 0 0
12 (86 DEAD LinStatic -5,513 -1,974 15,884 0 0 0
13 ;'90 DEAD LinStatic 2,278 8,047 10,773 0 0 0
14 (94 DEAD LinStatic 21,162 14,95 51,254 0 0 0
15 3'108 DEAD LinStatic -31,837 14,155 60,821 0 0 0
16 |

17 |

18 | Totale peso proprio

19 [=soMMA(F4:F15)

20| I

21 |

22
N° piani: 3

Mg per piano: 450 (mq)

Peso per piano al mq: 10 kN/mq

Peso proprio totale: 403,716 kN

Carico solai: 450 mqg x 10 kN x 3 piani = 13.500 kN
Carico totale: 13500 kN + 403,716 kN = 13.903,716 kN
N° nodi: 66

N° nodi angolari: 4

N° nodi perimetrali: 26

N° nodi centrali: 36



Per applicare i carichi differenti sui nodi su SAP2000 occorre prima di tutto sbloccare la struttura
deselezionando I'icona del lucchetto in alto a sinistra, in seguito definire un caso di carico. Si va su Define >
Load Patterns, si sostituisce “F” al Dead che si trova sulla casella in alto e si preme “Add New Load
Pattern”.

2 5422000 1600 Ultimate « 12 = a X
File Edt View Define Draw Select | Assign | Anslyze Diaplay Design  Options Took Help
DAHG 2 /B P@A  om rjwe 2 MG Nrt- - T-@- -
M XY Plane @ 20 Fame » -
[&] '
L]
\ bt
\ _—
M Jont Losds ’ [ﬁ 7R I
= Frame Loads ? |8 Displecements |
D 4
I
I Joint Patterns.
b1 g Assignto Geoup.. Ctrle Shéte & { / P
H = 2
I Cloar Display of Assigns W 1 >, i
] / L
: Copy Asgns ; p
-5 Paste Assig i
n |74 174
.
2% Ponts B Frames Sciected X546 Y2013 2000 [GLOBAL s ]

Nel nostro caso abbiamo considerato ciascuna F come la somma dei contributi puntuali del peso proprio
della struttura e del carico dei solai.

Un’alternativa per non sommare prima i due carichi sarebbe stata quella di definire una “Combinazione” di
carico tra F (in questo caso solo dei solai) e Dead, il peso proprio della struttura.

Per assegnare i carichi puntuali basta selezionare i nodi, andare su Assign > Joint Loads > Forces e indicare

" ou

il valore su “Force Global Z” con il segno “-“ davanti (perché verso il basso), dopo aver indicato secondo la

tendina che si tratta del caso di carico F.
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A questo punto si fa ripartire I’analisi, questa volta con F.
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Set Load Cases to Run
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Su Display > Show Forces/Stresses > Frame Cables/Tensions, & possibile vedere il grafico delle
sollecitazioni sulle aste della travatura.
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Una volta aperte le tabelle dei risultati, andra analizzata quella degli Element Output, in particolare
Element Forces — Frames. La colonna che interessa in questo passaggio € quella di “P”, lo sforzo normale.

1 .

2 | Frame @ Station OutputCase CaseType P V2 V3 T M2 M3 FrameElem ElemStation
3 '378 O/F LinStatic = -1567,741 -0,336 o 0 o 0 378-1 o
4 '378 2,12132 F LinStatic ' -1567,405 1,665E-16 0 0 0 0,3568 378-1 2,12132
5 '378 4,24264 F LinStatic = -1567,069 0,336 ] 0 0 -6,661E-16 378-1 4,24264
6 '36 3F LinStatic = -1365,416 ] 0 0 0 0 36-1 3
Fe 7'36 1.5/F LinStatic = -1365,079 t] ¢} 0 0 0 36-1 15
8 '36 0OF LinStatic = -1364,743 0 0 0 0 0 36-1 0
3 '334 OF LinStatic —1272;717 -0,336 (] 0 0 0 334-1 4]
10 ’334 2,12132 F LinStatic !12?2;38 1,665E-16 0 0 0 0,3568 334-1 2,12132
11 ,'334 4,24264 F LinStatic -1272,—044‘ 0,336 (¢} 0 0 -6,661E-16 334-1 4,24264
12 '1 3F LinStatic | -1215,117 0 0 0 0 01-1 3
13 "1 1,5F LinStatic ~1214;78 o o 0 o 01-1 1,5
1401 0F Linstatic | -1214,444 0 0 0 0 01-1 0
15 '464 OF LinStatic = -1200,923 -0,336 ¢} 0 0 0 464-1 o
16 '2164 2,12132 F LinStatic | -1200,587 1,665E-16 0 0 0 0,3568 464-1 2,12132
17 '464 4,24264 F LinStatic —1200;251 0,336 (] ¢} 0 -6,661E-16 464-1 4,24264
18 ’149 0OF LinStatic = -1071,773 -0,336 0 0 0 0 149-1 0
19 _"149 0,5F LinStatic -1'671,773' -0,224 0 0 o 0,1402 149-1 0,5
20 '149 1F LinStatic | -1071,773 -0,112 0 0 0 0,2243 1459-1 1
21 :'149 1,5F LinStatic = -1071,773 -5,551E-17 o 0 o 0,2523 149-1 1,5
22 [1a9 2F LinStatic | -1071,773 0,112 0 0 0 0,2243 149-1 2
23 "149 2,5F LinStatic -1671,773- 0,224 0 0 C 0,1402 149-1 2,5
24 1149 3F LinStatic | -1071,773 0,336 0 0 0 1,665E-16 149-1 3
25 "191 OF LinStatic -1070,014 -0,336 (0] 0 0 0 191-1 0

La procedura da eseguire e quella di dividere gli sforzi di compressione (quelli con il segno negativo) e gli
sforzi di trazione (con segno positivo) in quattro categorie ciascuno.

Ognuna di queste avra un proprio valore massimo, ed e quello che andra preso in considerazione per il
dimensionamento delle sezioni.

Per le aste sollecitate a trazione il calcolo € semplice: basta inserire i valori massimi delle quattro categorie
sul foglio di calcolo Excel che ci & stato fornito precedentemente. Sulla colonna Amin, secondo le operazioni
predefinite, risultera il valore di area minima per sopportare lo sforzo di trazione. Questo valore andra
confrontato con quelli riportati su un sagomario (nel nostro caso quello della Oppo); ovviamente andra
scelta la sezione uguale o immediatamente superiore al valore ottenuto dai calcoli.

Calcolo dellarea minima da sforzo normale di trazione ]
fa Amin |
Mpa cm2
= 223 .81 14.46
223.81 28.46
223,81 40,55
223,81 57.60




Per le aste sollecitate a compressione invece il procedimento si complica leggermente perché oltre I'area
minima andra rispettato il valore del giratore di inerzia minimo, termine che rappresenta la presa in
considerazione dell’effetto del Carico Critico Euleriano. Se il profilo scelto avesse un raggio di inerzia piu
piccolo del minimo calcolato, andrebbe ‘scartato’ e scelto quello il cui giratore di inerzia sia uguale o
superiore a quello da tabella.

Calcolo dellarea minima da sforzo di compressione = s L < 1 G 3 Ingegnerizzazione sezione e verifica snellezza per una
5 7 Calcolo dellinerzia minima per sforzo di compressione (instabilita euleriana) s b
(resistenza materiale) embratura principale (< 200)
N fyk ¥ omo fyd A_min = beta 1 Lam* rho_min I_min A design | | design tho_min | lam
kN | NWmm2 N/mm2 cm2 Mpa m [ cm cmé cm2 cmd cm
-386.59 35,00 1,05 223.81 17.27 210000.00 .00 3.00 96.23 3.12 168 1940 | 437 478 62,76
790,24 35,00 .05 223.81 3531 210000.00_| 1.00 3.00 96.23 312 343 39,50 2247 7.54 39.79
-1175,80 | 235.00 105 | 22381 52.54 210000.00 00 3.00 96.23 312 511 52.80 4696 9.43 31.81
-1667.74 | 23500 1.05 | 22381 70.05 210000,00 | 1.00 00 | 9623 312 681 70.70 8869 11.20 26.79

Una volta operata la scelta, una verifica immediata per le aste sollecitate a compressione € quella che
consiste nel vedere che il giratore di inerzia del profilo sia maggiore o uguale al rapporto tra la lunghezza
libera di inflessione dell’asta (lo) e 200.
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1143x4,0
1143x45
139,7x29
139,7x3.6
139,7x4,0
139,7x4,5

4con.nn

219,1x4,0
219,1x5,0
219,1x5,9
273,0x4,0
2730x56
273,0x6.3
3239x40
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3239x7.1

11,00
12,10
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12,20
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14,90

4n 4an
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26,40
31,00
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3180

46,20
55,60

88,70
87,10
1410
138,0
136,0
134,0

ano n

350,0
343,0
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562,0
538.0
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7840
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40 on

27,00
33,60
39,50
33,80
47,00
52,80
40 20

58,90
70,70

2110
234,0
2920
357.0
393.,0
437,0

coon

1.564
1.928
2247
3.058
4206
4.696

5144

7.453
8.869

36,90
41,00
41,80
51,10
56,20
62,60

o7 An

143,0
176,0
2050
2240
308,0
3440
3180

460,0
548.0

3,900
3,890
4,840
4810
4,800
4,780

c oasn

7,610
7,570
7,540
9,510
9.460
9,430
1130

11,20
11,20

L'ulteriore verifica da operare, questa volta per la struttura, consistera nell’andare a sostituire su SAP2000 a
ciascuna asta il proprio profilo e far correre nuovamente I'analisi con il peso effettivo; per poter visualizzare
il numero dell’asta, basta andare sull’icona con il quadratino spuntato nella barra in alto, e spuntare Labels

sulla sezione Frames.
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Essendo il procedimento di sostituzione per singolo elemento molto lungo, una verifica approssimativa
consisterebbe nell’applicare a tutte le aste uno stesso profilo, calcolandone uno medio tra tutti quelli

ottenuti.



